ONPOINT _
HealthData =~ Support Documentation

Intro to PGP Encryption & SFTP - Live Demo Recap

On May 14, 2025, Onpoint held a webinar for submitters to the Health Care Payments Data (HPD) program
that reviewed the file encryption and secure submission process. This document provides an overview of the

process.

Getting Started

If an organization does not already have PGP or SFTP applications installed, we recommend GPG4Win (which
includes Kleopatra, see the logos on the bottom left) for PGP key management, encryption, and decryption.
We recommend WiInSCP (see below right) as an SFTP client. Onpoint will try to provide support for any tools
that you choose but we have extensive experience with these recommended tools.

EGPKIeopatra m WinSCP

Free FTP CLIENT

=l Gpg4win /

GnuPG for Windows

Name Date modified Type Size
e gpgAwin-4,4.0 (2) 4/3/2025 8:01... Application 35,158 ...
% WinSCP-6.5-Setup 4/3/2025 8:00 ... Application 11,924 ...
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Creating a PGP Pair

To create a new PGP key pair, open Kleopatra and select New OpenPGP Key Pair from the File Menu.

™ Kleopatra - o X
File View Certificates Tools Settings Window Help
&= New OpenPGP Key Pair... Ctrl+N j E B 2
#® New S/MIME Certification Request... A toend_Seuremdy | G
Q  Lookup on Server... Ctrl+Shift+]
® |mport... Ctrl+1
3 3.3.0 (6pg4win-4.4.0)
aypto software GruPG.
(=] ther 2 publ tificate) or your own private key.
2ded to decrypt or gn.
2 used by others to verify your identity or encrypt to you.
& Decrypt/Verify... § on Wikpedia.
G Sign/Encrypt... — —
G @] [a5
B Sign/Encrypt Folder... + <

New Key Pair Import

Create Checksum Files...
Verify Checksum Files...

Close Ctrl+W

= Quit Ctrl+Q

Enter a name and email address for the key pair. This can be any name and email address. The email address
entered will not be used for communication.

You may choose to protect the key with a passphrase. This is not required, but it is recommended for security.
If you set a passphrase, you must store it securely for later use. You will need to enter the passphrase
whenever you encrypt or decrypt files using the key. The passphrase cannot be recovered or reset. If it is lost
or forgotten a new key pair must be generated.

-
File View Certificates Tools Settings Window Help

N [ R B OE Q &= & &
SignEncrypt  DecryptNerify  Import Lookup on Server | Certificates Notepad Smartcards  Groups

™ Create OpenPGP Certificate - Kleop... X

Enter a name and/or an emai address to use for the certificate.
Name
Welo  youname
Keopa  Email address
Formo Emal@example.com it
8 Protect the generated key with a passphrase.
¥ Advanced options
Key Material

[rea208 N

8 vaid until (between 5/3/2025 and 2/5/2106): 5/2/2028

| o Cancel

The “Key Material” used to create the key (located in the bottom half of the screenshot above) must be RSA
and a minimum of 2048bits. A higher number will result in more secure encryption but will take slightly longer
to generate the key and when you use it to encrypt and decrypt. The options Onpoint accepts are rsa2048,
rsa3072, rsa4096.

You have the option to set an expiration date for your key pair. When the key expires it can no longer be used
for encryption and a new key must be generated and provided to Onpoint. Expiration is not required but is
recommended for security. You can adjust the length of key validity to your preference or organizations
policies. If you do not check the Valid Until box, the key will remain valid indefinitely.
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After adjusting the key settings and clicking OK, you will be asked to enter a passphrase for the key if you
choose to set one.

™ Kleopatra
File View Certificates Tools Settings Window Help
[ it BB E Q | B = &
SignfEnarypt DecryptNesify  Import Lookup on Server | Certificates  Notepad Smartcards = Groups
™ Creating Key Pa Kieopatra

The process of ceating a ke ire several minutes. ..

¥ pinentry-qt5 -

Please enter the passphrase to o
{ protect your new key Cancel
Youi can learn ma " Passphrase: ""E§" >

Repeat: ves]
OK Cancel

New Key Pair Import

After entering a passphrase, a pop up will appear showing that a keypair has been created successfully.

In the Kleopatra Certificates pane, you will now see your new keypair listed in bold. The bold text indicates that
you hold both the private and public half of this key pair.

™ Kleopatra
File View Certificates Tools Settings Window Help

k2 it = BB Q B B &
SignfEncrypt Decrypt/Nerify  Import Lookup on Server  Certificates  Notepad Smartcards  Groups

b Al

LA
Name E-Mail Status alid Fror alid Unt Key ID
YourName Email@example.com certif... 5/2/... 5/2/... C969 1F21 ...

™ Success - Kleopatra

X

o A new OpenPGP certificate was created successfully.
Fingerprint of the new certificate: 0DCF C818 643C AG0C 66A8 38FE C969 1F214C72 7079
oKk |

You must export the public half of the key pair from Kleopatra so that you can send it to Onpoint. Right click on
your key name and select Export from the drop-down menu.

.
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™ Kleopatra - (=] X
File View Certificates Tools Settings Window Help

N [ R B 5 Q | B &8 &
SignfEnaypt DecryptNesify  Import Export Certfy Lookup onServer | Certificates Notepad Smertcards  Groups

G a

Name E-Mail Status alid Fror alid Uni Key ID

[VourName | Email@example.com certif... 5/2/... 5/2/... C969 1F21 ... ]
Q@ Update Certificates

& Certify...
#  Revoke Certification...

Disable Certificate

Change End of Validity Period...
Change Passphrase...
Add User ID...

#  Revoke Certificate...
T Delete Del

2% Create Group...

& Export... Ctri+E Export the selected certificate (public key) to a file
& Backup Secreh(eys...

@ Print Secret Key...

# Publish on Server... Ctrl+Shift+E

@ Details

Save the key. We strongly recommend including the word “public” in the key name so that you can differentiate
it from the private key.

™ Kleopatra

™ Export OpenPGP Certificates X
< e: Ay « PGP&SFTP » 2 Send to Onpoint - public C Search2Sendto.. 2
Organize *  New folder =~ 0

2 Home Name Date modified Type Size
A Gallery No items match your search.
@ Desktop +
< Documer#
L NAauwmlaz &
File name: | YourPublicKey_public "

Save as type: OpenPGP Certificates (*.asc *.gpg *.pgp)

~ Hide Folders Cancel

.
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Once the public key has been exported and saved, send it to Onpoint along with your SFTP account
registration.

You may also want to export the private half of your PGP key pair. You do not need to do this if you are going
to use Kleopatra for encryption and decryption, but you still can if you would like to store a secure back up in
another location.

To export the private key, right-click on the key name and select Backup Secret Keys from the drop down

™ Kleopatra - a]
File View Certificates Tools Settings Window Help

&2 i B 5 B Q s B B bS]
SignEncypt DecryptNerify Import Export Certify LookuponServer  Certificates Notepad Smartcards  Groups

G oA
Name E-Mail Status alid Fror alid Uni Key ID
Yourt*~— - — certif... 5/2/... 5/2/... C969 1F21 ... l
Q Update Certificates
& Certify...

# Revoke Certification...

Disable Certificate

Change End of Validity Period...
Change Passphrase...
Add User ID...

# Revoke Certificate...
7 Delete Del

2t Create Group...

% Export... Ctrl+E
= Backup Secret Keys... 5
Print Secret Key...
# Publish on Server... Ctrl+Shift+E
Details

Save the private key. We strongly recommend including the word “private” in the key name. A private PGP key
should be treated as if it were a password. It should never be shared with anyone (including Onpoint). Do not
send the private half of your PGP key pair to Onpoint.

™ Kleopatra
™ Secret Key Backup X
< vi 4 « PGP&SFTP » 2 Keep for yourself - private > Search 2 Keep for... 2
Organize *  New folder =~ 0
2 Home Name Date modified Type Size
E] Gallery No items match your search.
@ Desktop »
4 Documer #

L NAauwmnmlAas &

File name} | YourPrivateKeyPGP SECRET

Save as type: Secret Key Files (*.asc *.gpg *.pgp)

~ Hide Folders Save Cancel
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Importing Onpoint’s Public Key into Kleopatra

When you send files to Onpoint you will encrypt them using Onpoint’s public key. To do this, you must import

the public key you received in the Onpoint welcome email into Kleopatra.

To import the public key, drag and drop it into the Certificates pane in Kleopatra.

™ Kleopatra
File View Certificates Tools Settings Window Help
0 & KRN Y Q 5] El =1 2

SignEncypt DecryptNesify  Import Export Certfy LookuponServer  Certfficates Notepad Smartcards  Groups

t Al
c oA
Name E-Mail 0 Onpoint welcome e +
Lo Emali@example.com € A (&} D > PGP&SFTP > 0 Onpoint welcome email > Search
o ® New % @ @ B W mwsot® = View
n 5 Home Name ’ Date modified Type Si
B ) Gallery * Older-files 4/3/2025 8:04 ... File folder
N @ Onpoint - User Guide for SFTP Data Exchanges with O...  1/21/2025 5:03 ... Microsoft £ 2
+ Copy
@ Desktop  # | o ONPOINT_HEALTH_DATA_PROD-r2.pubkey 3/24/2023 6:10 ... OpenPGP T...

& Documents#

4 Downloads #

8 Pictures  #

@ Music »
i Videos »
> @@ This PC
> 4@ Network

3items  1item selected 2.17KB

You will be asked to certify the key you are importing. Certification means that you trust that the key belongs to
the person who sent it to you. It is important to take this step after creating your own key because you will use

your key to perform the certification.

Select your key name from the Certify with drop down. Click Certify.

(o]

L) ™ Certify Certificate: ONPOINT_HEALTH_DATA_PROD - Kleopatra X
File View Certificates
o _  Verify the fingerprint, mark the user IDs you want to certify, and select the key you want to certify the user IDs with.
Za (a B pote: Only the fingerprint dearly identifies the key and its owner.
SignfEncrypt  Decrypt/Nerify  Impe
Figerprnt:  870F B656 F324 607E C372 2882 B33 9804 BOIC E40A
) T Certify with: YourName <Email @example.com> (certified, craated: 5/2/2025)
C: M imported Certhcates gy )NPOINT_HEALTH_DATA_PROD < support@onpointhealthdata.org>
Name
ONPOINT_HEALTH_ 39...
P Advanced
© Cancel
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If you set a pass phrase for your key pair, you will be asked to enter it.

™ Kleopatra
File View Certificates Tools Settings Window Help
Q2 i B B B Q El =} A
SignfEncrypt  DecryptNerify  Import | t Lookup on Server  Certificates Notepad Smartcards  Groups
\
3 a Imported Certificates Q
= = |
Name E-Mail Status alid Fror alid Uni Key ID
ONPOINT_HEALTH_DATA_PR... support@onpointhealthdata.org not ce... 9/11/... B33B 9804 B9...
¥ pinentry-qt5 - X

Please enter the passphrase to unlock the OpenPGP secret key:
“YourName <EmalGexample.com>”
Q 2048-it RSA key, ID C9691F214C 727078,

| created 2025-05-02.

Passphrase: sesssses R

Coge ) ome |

Once you have entered your passphrase and successfully certified Onpoint’s public key, you should now see
Onpoint’s key in the Certificates pane.

™ Kleopatra - (=] X
File View Certificates Tools Settings Window Help

0 ta A Q El = b5
SignEncrypt DecryptNerify  Import Export Certify Lookup onServer  Certificatss Notepad Smartcards  Groups
1
|

P P pr &
3 Al Imported Certificates [x]
Name E-Mail Status alid Fror alid Uni Key ID
IONPOINT_HEALTH_DATA_PR..isupport@onpointhealthdata.org certified 9/11/... B33B 9804 B9... |
YourName b Email@example.com certif... 5/2/... 5/2/... C969 1F21 ...

Notice that it is not in bold text. This is because you have only the public half of the key pair. This means you
would not be able to use this key to decrypt.

You now have your key pair set up and Onpoint’s public key imported. You are ready to encrypt files.
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Encrypting Files Using Kleopatra

To encrypt a file either click Sign\Encrypt and select the file you want to encrypt from the File Explorer
window. Alternatively, you can simply drag the file(s) you want to encrypt over the Kleopatra window and drop
them there, as shown in the image below.

™ Kleopatra
File View Certificates Tools Settings Window Help

N 4 R B 5 Q [ El & 2
SignEnaypt DecryptNerify Import Export Certify LookuponServer  Certficates Notepad Smartcards  Groups

Al
C A Imported Certficates 0‘
Name E-Mail Status alid Fror alid Unt Key ID i
ONPOINT_HEALTH_DATA_PR... support@onpointhealthdata.org certified 9/11/... B33B 9804 B9...
YourName Email@example.com certif... 5/2/... 5/2/... C969 1F21 ...
b+ Copy

A Sign/Encrypt files dialogue will appear. The settings in this step are crucial. Doing this incorrectly will prevent
Onpoint from decrypting the files and they will be rejected.

™S gn/Encrypt Files - Kleopatra
File View Certificates

N [ =
SignEncrypt DecryptNerfy  Impt

Sign / Enarypt Files
Prove authenticity (sign)

@ sonas: ¥ vourName <Emai@exampie.com> (certified, created: 5/2/2025) v/ 8%

En t A

ITyp!
(3 Al Imported Certificates o
[ Encrypt for me: (v 2
Name s
Enaypt for others: W ONPOINT_HEALTH_DATA_PROD <support@onpontheaithdata.org> (certified, Open €3 | 8%
ONPOINT_HEALTH_ - R

(XK 2%

YourName Lo

() Encrypt with password. Anyone you share the password with can read the data,

Output
Output files/foider:

. C: Users/Administrator Desktop a R

@ Enarypt / Sgn each file separately.

{Sign / Encrypt Cancel

The settings in this step are crucial. Doing this incorrectly will prevent Onpoint from decrypting the files and
they will be rejected.

¢ Files sent to Onpoint must be ENCRYPTED with Onpoint’s key and SIGNED with your key.

.
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e Sign as: Select your key name from the drop down.
o Encrypt for Me: UNCHECK this box.
e Encrypt for others: Select Onpoint’s key name (ONPOINT_HEALTH_DATA_ PROD) from the drop

down.

¢ Encrypt with Password: UNCHECK this box. Do no encrypt with a password.

e Output files/folder: Select a location to save the encrypted files.

e Encrypt/ Sign each file separately: CHECK this box. We need the files encrypted separately.

An Encrypt-to-Self Warning will appear. Click Continue. You will not be able to decrypt the encrypted files
because they now are encrypted with Onpoint’s key. You will still be able to read your original files.

™ K¢
(o}
File View Certificates
i n il
o % ESgn/IE crypt Files
i Prove authenticity (sign)
SignfEncrypt  DecryptNerify  Imp
@ signas: YourName <Email@example.com> (certfied, created: 5/2/2025) 2
Al
= e enaypt
2 A Imported Certficates
N A () Encrypt for me : o
ame % T
& Enayot for ™ Encrypt-To-Self Warning - Kleopatra XL a =
ONPOINT_HEALTH, 39...
None of the recpients you are encrypting to seems to be your own, 3:
YourName
This means that you will not be able to decrypt the data anymore, once enarypted.
Do you want to continue, or cancel to change the recpient selection?
[__J Do not ask again
> Continue © Cancel
) Encrypt wit
Output
Output files/folder:
. C:fUsers/Administrator Desktop a @R
@ Enarypt / Sign each file separately.
Sign / Encrypt Cancel
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Sending Files to Onpoint Using PGP and SFTP

To send your encrypted files to Onpoint, you will need two applications: WinSCP and PuTTYgen.

WinSCP is an SFTP client that can be used to send the files to Onpoint and PuTTYgen — accessible within
WinSCP — will generate an SSH key pair that will enable you to connect to Onpoint’s SFTP server.

Generating an SSH Key Pair

Open WinSCP and In the Login window click the Tools menu and select Run PuTTYgen.

%, Document
Left Mark Files Commands Tabs Options Right Help
= Transfer Settings Default v 6~
i Documents — Documents B New Tab ~
@My docum ~ I~ ¥]~ % Login - x 1S &=~
New Site Session New ~
C:\Users\Admini \Doc/ TestUSer1@transfer.onpointhealthdata.orc FI: :votocol:
Name Size Import Sites... — Post rimbe: Changed
. Import/Restore Configuration... linthealthdata.org 2 . 4/3/20257:594...
Export/Backup Configuration... Passord:
Clean Up...
Run Pageant
F Run PuTTYgen A
Check for Updates
Preferences...
About...
[ Teols T Memage Bllogin |v Close Help
8 Show Login dialog on startup and when the last session is closed
0Bof0Bin0of0 4 hidden 0Bof0Bin0of0 4 hidden

In the PUTTY Key Generator, you must select RSA as the key type and a minimum of 2048 bits in the
generated key.

Click Generate.

& PUTTY Key Generator X
File Key Conversions Help

Key
SIC Nokey

Actions

Generate 3 publc/private key pair Generate I

Load an exigting private key file Load

Save the generated key ave ve te Key

Parameters

Type of key to generate: _ N . B
OR: (ODSA _J ECDSA (O EdDSA ) SSH-1 (RSA)

£ Number of bits in a generated key 2048

While the generator is running, move your mouse randomly. This creates randomness for your key.

Intro to PGP Encryption & SFTP (Confidential) 10 All content © Onpoint Health Data m



ol

B PUTTY Key Generator
File Key Conversions Help

Key
¢ Public key for pasting into OpenSSH authorized_keys file
b sshesa AAAABINzaC lyc2EAAAADAQABAAABAQCMAS TohWXipp 1yCfarB Tu 1IWEQdUgNyBckq YF

+Neflxt| AXE TioMebgSn TVD ShLx2WyD 2ow VusHNBDOcE 3hPVNN 52 S 3rd Yg Wb TZ5nvvJF Y 3nFdw IniG6ddBoM
P TZEaSvRMSuZhGIFSTogtlppGwy SW/FT784AEqUNMxDal SufVEIBIWY TUWyIDzzdkyMNXCEBCLOGCXinRwM
oJ1asm1+2M3 10 EAFQyPIOrZrAmOhoc BKXGGMOSBvh XEdDKyRZdK
+hPdf6ce/LdkGLA0EWqSRt 2k 0WspOPPR T GsIIF 25425 PrwCBvRd2/ECPEY ts VbymWITUSIX rsakey-
Keyfingemant:  sshrsa 2048 SHA56:a)0G0VBusyQkD86yHNSOBF/TTXGXITP IwS50om /0

Key comment: rsakey-20250502

Key passphrase: | [
Confem passphrase:

Actions
Generate a public/private key pair [ Generate ]

Load an existing private key file Load
Save the generated key Save public key Save private key

Parameters

Type of key to generate:
ORSA (ODSA (O ECDSA (O EdDSA () SSH-1 (RSA)

Number of bits in a generated key 2048

You can create a passphrase (shown in the screenshot above), which is not required but is more secure. Like
the passphrase for your PGP key pair, this passphrase cannot be recovered. If it is lost, a new SSH key must
be generated.

Save the public key and send it to Onpoint. Save the private key and keep it for yourself. Never share with
anyone, including Onpoint.

Upon receipt of your SSH key, Onpoint will use it to create your SFTP account.
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Logging into the SFTP Server

B Documents — Win®
Left Mark Files Commands Tabs Options Right Help

Transfer Settings Default
i Documents - Documents B New Tab ~

&My docum ~ (7~ ¥~ % Login
NeiSE Session
CAUsers\Administrator\Dod TestUSer1@transfer.onpointhealthdata.or| Fsl:ivmmh
VName 2 Size Host name:

.. transfer.onpointhealthdata.org

Tools v Manage >

B Login

8 Show Login dialog on startup and when the last session is closed

080f0Bin0Of0O

v

4 hidden 0Bof0Bin0of0

- &~

- X
New ~
Port number: Changed
2% . 4/3/20257:594..

User name: Password:
YourSFTPUsername
Sve  |w

Clos|

| Advanced... |w

Session

Advanced...
Edit Raw Settings...
Transfer Settings Rule...

Global Preferences

Logging...

4 hidden

When you open the WIinSCP application, a login screen appears. Enter the following information into the

appropriate fields:

o File protocol: SFTP

e Host Name: transfer.onpointhealthdata.org

e Port number: 22

¢ Username: The username you were given by Onpoint when your account was created.

e Password: Leave blank — instead click Advanced and select Advanced from the drop-down men.

In Advanced Site Settings, go to the Authentication tab. In the Private key file field, click the three dots (...) in

the lower right corner.

s i :
Advanced Site Settings ? X
i

Environment ("] Bypass authentication entirely
Directories Authentication options
Re(ycle_bm B Attempt authentication using Pageant
Encryption
SETP B Attempt 'keyboard-interactive’ authentication
Shell B Respond with a password to the first prompt

Connection
Proxy Authentication parameters
Tunnel [_]) Allow agent forwarding

S5H Private key file:

i Key exchange

Bugs Tools v

Note

GSSAPI
@ Attempt GSSAPI authentication
[_] Allow GSSAPI credential delegation
Color oK Cancel Help
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In the selection box that pops up, select your private SSH key from wherever you have saved it. Click OK.

i Select private key file X
& > v 1 T Desktop > PGP&SFTP » 2 Keep for yourself - private v C Search 2 Keep for ... 2
Organize ¥  New folder =~ 0 0

> Home Name ) Date modified Type Size

R Gallery [ PRIVATE-SSH_demo.ppk 1/21/2025 9:35 ... PPK File 2 KB
[ PrivateSSHKey.ppk 5/2/2025 6:53 ... PPK File 2KB

@ Desktop  # Type: PPK File

& Documents# Size: 1.57 KB

$-Downloads» Date modified: 5/2/2025 6:53 PM

I8 Pictures #

@ Music »
i Videos *
> @@ This PC
> & Network

If you set a passphrase for your SSH key, you will be prompted to enter it. You are now logged into Onpoint’s
SFTP Transfer Server. You will see a PROD and TEST Directory.

T / - TestUSer1@transfer.onpointhealthdata.org — WinSCP - (a] X
Local Mark Files Commands Tabs Options Remote Help
] .2 '@ synchronize M &® =1 ) (¥ Queue v Transfer Settings Default v 8~
B TestUSer1@transfer.onpointhealthdata.org X B New Tab ~
GMydocum~[Z~Flv | -~ - mEm A LD %/ <~ @~ - o B S| R Find Files | B B~
Upload ~ | X £dit ~ X «/ 2 Properties ~ > 4# Download ~ It~ X o [ Properties ~ > i+ =] V]

C\UsersAdminsotonDocuments 0o
Name Size Type Changed Name Size Changed Rights ~ Owner
- Parent direc... 4/3/2025 7:594... .

“2PROD 11/24/2021 4:48... rwxr--r... -

i - 11/24/2021 448... roxr—r.. -
0Bof0Bin0of0 4 hidden 0Bof0Bin1of2

SFTP-2 fa) nnn-20
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Sending Files to Onpoint

To send a test file, enter the TEST directory and drag and drop a file from your computer into it.

C:\Users\Administrator\Documents\ /TEST/
Name Size Typ Upload ? x 2 Rights  Owner
= Par /&) Upload file TestFile.tct.gpg’ to remote directory:
N = |25 6:320..  rwxr--r... -
Transfer settings )25 6:32:... rwWxr--r... -
Teantes pes B )25 6:375...  TWXI--T... -
() Transfer in background (add to transfer queue) 025 9AT.... | Wr=-F... -
Transfer settings... |w OK Cancel Help
8 Do not show this dialog box again %
Click OK in the Upload pop up.
Once you have uploaded the test file, you may see the following error message:
Error ? X
Upload of file "TestFile.txt.gpg’ was successful, but error (
0C occurred while setting the permissions and/or
timestamp. 1
If the problem persists, turn off setting permissions or preserving 1
timestamp. Alternatively you can turn on 'lgnore permission errors'
option. 1
The server does not support the operation. 1} :
Error code: 8 1
Error message from server (US-ASCII): SETSTAT unsupported
v
Abort Retry Skip Skip all Help
|

This error occurs because WIinSCP tries to change the properties of the submitted file after it has been sent to
Onpoint. You have two options for dealing with this error. First, you can ignore it by selecting Skip All. At this
point, Onpoint has already received the file, and this error does not affect Onpoint’s ability to receive or

process the submission.
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To no longer see this error, you can go to Options > Preferences in WinSCP. Select the Transfer tab and
click Edit with the Default transfer settings selected. In the Transfer Settings pop up, uncheck the Preserve

timestamp box.

Preferences X
Search Transfer settings presets
Environment Preset description Auto
Interface Default
“Nesdow b Transfer settings 7 X
-~ Commander Binary
Explorer New and updated files only  Transfer mode Filename modification
P.‘n'::""’g“ Exclude directories O Text (plain text, html, scripts, ..) © No change
.Eile colors © Binary (archives, doc, ...) () Upper case
Remote () Automatic ) Lower case
- Local Transfer following files in text mode O Lower case 8.3
Editors ® Shtrrh ® e * te * nhee * TP
Internal editor Shtml; *.htmy; *.tt; *.php; *.php3; *.cgi; "¢ 2 Replace \:*7'.. l'
T Ding dibiog Upload optio.ns. Common opt.ions |
. Background () Set permissions: () Preserve timestamp |
- Endurance rW=r==r== (+X) Including directories
:‘« nt'yk Transfer type: Binary Ignore permission errors @ Calculate total size ‘
u
Logging [T Clear 'Archive' attribute Speed (KB/s): Unlimited v l |
Integration Remove BOM and EGF marks R
icati Add... Edit... Download options
-~ Applications 8 Encrypt new files o
Commands - (") Preserve read-only
Remove Duplicate
Storage
Updates ) Announce when transfer ¢ Other
File mask:
| v]|  Edit..
mask hints
‘ ) (_) New and updated files only () Exclude hidden files
hidden 0B of 2.19 KB in 0 of 5 Ll sty oadom
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